
 

 External device connection manual for TOP Design Studio 1 / 15 

 

DONGBU ROBOT CO., LTD 

iM-U Series  

Ethernet 
 Supported version TOP Design Studio V1.0 or higher  

 

CONTENTS 

We would like to thank our customers for using M2I's "Touch 

Operation Panel (M2I TOP) Series". Read this manual and familiarize 

yourself with the connection method and procedures of the “TOP and 

external device”. 

 

1. System configuration Page 2 

 

 

Describes the devices required for connection, the setting of 

each device, cables, and configurable systems. 

2. External device selection  Page 3 

 Select a TOP model and an external device. 

3. TOP communication setting Page 4 

 Describes how to set the TOP communication. 

4. External device setting Page 9 

 Describes how to set up communication for external devices. 

5. Supported addresses Page 10 

 Refer to this section to check the addresses which can 

communicate with an external device. 
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1. System configuration 

The system configuration of TOP and “DongBu Robot Co,. Ltd – iM-U Series Ethernet” is as follows: 

 

Series CPU Link I/F Communication method System setting Cable 

iM-U All CPU Ethernet Port TCP 3. TOP communication 

setting 

4. External device 

setting 

Twisted pair cable*Note 1) 

*Note 1) Twisted pair cable 

- Refer to STP (Shielded Twisted Pair Cable) or UTP (Unshielded Twisted Pair Cable) Category 3, 4, 5. 

- Depending on the network configuration, you can connect to components such as the hub and transceiver, and in this case, use a 

direct cable. 

 

 

■ Connectable configuration 

 

ㆍ1:1 connection (one TOP and one external device) connection 

 

 

ㆍ1:N connection (one TOP and multiple external devices) connection 

 

 

ㆍN:1 connection (multiple TOPs and one external device) connection 
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2. External device selection 

■ Select a TOP model and a port, and then select an external device. 

 

 
 

 
 

Settings Contents 

TOP Model Check the TOP display and process to select the touch model. 

External device Vendor Select the vendor of the external device to be connected to TOP. 

Select “Dongbu (DASAROBOT)”. 

PLC Select the external device to be connected to the TOP. 
 

Model Interface Protocol 

iM-U Series Ethernet Ethernet 
 

Please check the system configuration in Chapter 1 to see if the external device you want to 

connect is a model whose system can be configured. 
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3. TOP communication setting 

The communication can be set in TOP Design Studio or TOP main menu. The communication should be set in the same way as that 

of the external device. 
 

3.1 Communication setting in TOP Design Studio 

(1) Communication interface setting 

■ [Project > Project Property > TOP Setting] → [Project Option > “Use HMI Setup” Check > Edit > Ethernet] 

– Set the TOP communication interface in TOP Design Studio. 
 

 
 

 
 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 
 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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(2) Communication option setting 

■ [Project > Project Property > Device Setting > ETHERNET (1) > “PLC1 : iM-U Series”] 

– Set the options of the iM-U Series Ethernet communication driver in TOP Design Studio. 

 
* The above settings are examples recommended by the company. 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select the communication protocol between the TOP and an external device. 

IP Enter the IP address of the external device.  

Ethernet Protocol Selects the Ethernet protocol TCP between the TOP and an external device. Fixed 

Port Enter 9007, which is the Ethernet communication port number of the external 

device. 
Fixed 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Unicon Station Number Enter the prefix of an external device.  
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3.2. Communication setting in TOP  

* This is a setting method when “Use HMI Setup” in the setting items in “3.1 TOP Design Studio” is not checked. 
 

■ Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen.  

   

(1) Communication interface setting 

■ [Main Screen > Control Panel > Ethernet] 
 

 

 

Items TOP External device Remarks 

IP Address*Note 1) Note 2) 192.168.0.50 192.168.0.51  

Subnet Mask 255.255.255.0 255.255.255.0  

Gateway 192.168.0.1 192.168.0.1  

*Note 1) The network addresses of the TOP and the external device (the first three digits of the IP, 192 . 168 . 0 . 0) should match. 

*Note 2) Do not use duplicate IP addresses over the same network. 

* The above settings are examples recommended by the company. 

 

 

Items Description 

IP Address Set an IP address to be used by the TOP to use over the network. 

Subnet Mask Enter the subnet mask of the network. 

Gateway Enter the gateway of the network. 
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 (2) Communication option setting 

■ [Main Screen > Control Panel > PLC] 
 

 
* The above settings are examples recommended by the company. 

 

Items Settings Remarks 

Interface Select “Ethernet”. Refer to “2. External 

device selection”. Protocol Select the communication protocol between the TOP and an external device. 

IP Enter the IP address of the external device.  

Ethernet Protocol Selects the Ethernet protocol TCP between the TOP and an external device. Fixed 

Port Enter 9007, which is the Ethernet communication port number of the external 

device. 
Fixed 

TimeOut (ms) Set the time for the TOP to wait for a response from an external device.  

SendWait (ms) Set the waiting time between TOP’s receiving a response from an external device 

and sending the next command request. 
 

Unicon Station Number Enter the prefix of an external device.  
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3.3 Communication diagnostics 

■ Check the interface setting status between the TOP and external device. 

- Touch the top of the TOP screen and drag it down. Touch “EXIT” in the pop-up window to go to the main screen. 

- Check if the port (ETH1/ETH2) settings you want to use in [Control Panel > Ethernet] are the same as those of the external device. 

 

■ Diagnosis of whether the port communication is normal or not 

- Touch “Communication diagnostics” in [Control Panel > PLC]. 

- The Diagnostics dialog box pops up on the screen and determines the diagnostic status. 

OK Communication setting normal 

Time Out Error Communication setting abnormal 

- Check the cable, TOP, and external device setting status. (Reference: Communication diagnostics sheet) 

 

■ Communication diagnostics sheet 

- If there is a problem with the communication connection with an external terminal, please check the settings in the sheet below. 

Items Contents Check Remarks 

System 

configuration 

How to connect the system OK NG 
1. System configuration 

Connection cable name OK NG 

TOP Version information OK NG 

2. External device selection 

3. Communication setting 

Port in use OK NG 

Driver name OK NG 

Other detailed settings OK NG 

Relative prefix Project setting OK NG 

Communication 

diagnostics 
OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

External device CPU name OK NG 

4. External device setting 

Communication port name (module name) OK NG 

Protocol (mode) OK NG 

Setup Prefix OK NG 

Other detailed settings OK NG 

Ethernet port setting IP Address OK NG 

Subnet Mask OK NG 

Gateway OK NG 

Check address range  

OK NG 

5. Supported addresses 

(For details, please refer to the PLC 

vendor's manual.) 
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4. External device setting 

Set as below using “Operating Loader”. 

For a more detailed setting method than described in this example, refer to the user manual of the external device. 
 

1. Set the product front prefix setting Rotary switch to “0”. (SIO1, SIO2 prefixs are shared.) 

2. Go to Main > “3Parameter Setting” > “1.Basic” > “4.Miscel” path. Set EthProt item. 

Contents Comment 

EthProt 2 (Binary) 

3. Set as below through Main > “3.Parameter Setting” > “3.System” – Enter Password > “3.Ethernet” path. 

Contents Comment 

IP (IP Address) 192.168.0.51 

Sub (Subnet Mask) 255.255.255.0 

GW (Gateway) 192.168.0.1 
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5. Supported addresses 

The devices available in TOP are as follows:  

The device range (address) may differ depending on the CPU module series/type. The TOP series supports the maximum address 

range used by the external device series. Please refer to each CPU module user manual and be take caution to not deviate from the 

address range supported by the device you want to use. 

 

(1) Controller status/control 

Contents Bit Address Word Address Remarks 

Channel system status STAT1/0.0 – STAT4/2.7 STAT1/0 – STAT4/2 *F1 *1 *4 

Channel axis system status STATA1/0/0.0 – STATA4/5/2.7 STATA1/0/0 – STATA4/5/2 *F2 *1 *5 

System status information SYS0.0 – SYS2.7 SYS0 – SYS2 *F5 *1 *6 

Channel error code ––––– ERR1 – ERR4 *F4 *1 *7 

Channel error code (auxiliary) ––––– ERRSUB1 – ERRSUB4 *F4 *1 *7 

JOG move execution (CW/CCW) JDIR1/0 – JDIR4/5 ––––– *F3 *2 *8 

JOG move execution (CW) JCW1/0 – JCW4/5 ––––– *F3 *2 *17 

JOG move execution (CCW) JCCW1/0 – JCCW4/5 ––––– *F3 *2 *18 

JOG move ––––– JMOV1 – JMOV4 *F4 *9 

JOG motion ––––– JMOT1 – JMOT4 *F4 *10 

JOG speed ––––– JSPD1 – JSPD4 *F4 *11 

JOG moving speed ––––– JMSPD1 – JMSPD4 *F4 *12 

MPG ON/OFF MPG1 – MPG4 ––––– *F4 

MPG connecting axis ––––– MPGA1 – MPGA4 *F4 

ARCH ––––– ARCH1 – ARCH4 *F4 *3 *13 

Current motor position (Encoder) ––––– MECD1/0 – MECD5 *F2 *3  

Current motor position (Joint) ––––– MJIT1/0 – MJIT4/5 *F3 *3 *14 

Current motor position (XY) ––––– MXY1/0 – MXY4/5 *F3 *3 *14 

Current motor speed ––––– MSPD1/0 – MSPD4/5 *F3 *3 *15 

Alarm ON/OFF ALM1 – ALM4 ––––– *F4 *2 

Servo ON/OFF SERVO1 – SERVO4 ––––– *F4 *2 *16 

[Address format] 

*F1 Channel /information index 

*F2 Channel /axis /information index 

*F3 Channel /axis 

*F4 Channel  

*F5 Information index 

*1 Read only    *2 Write only   *3 32Bit address  

*4 This refers to the following bit-by-bit contents for the information index. 

Information index Bit pos Contents Comment 

0 0 Active Indicate channel activation status. 

 1 Run Indicate that the device is running. (motion, origin, jog, etc.) 

 2 PgmLoad Indicate that the motion program has been successfully compiled to be loaded. 

 3 Not decided  

 4 Not decided  

 5 ServoOn Indicate the On/Off status of the axis. 

 6 OrginOK Indicate that origin run has been completed. 

 7 Error Indicate that a warning has occurred in the channel. 

1 0 InPosition All axes of the channel are within the range in InposRange of the parameter. 

 1 InRange All axes of the channel are within the range in InRangeL and InRangeR of the parameter. 

 2 PgmRun Indicates that motion program operation is running. 

 3 StepRun Indicates that the motion program is under step operation. 

 4 DmoveRun Indicates that a motion move is running. 

 5 OrginRun Indicates that the origin is running. 

 6 JogRun Indicates that jog is running. 

 7 Not decided  

2 0 Not decided  
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 1 Not decided  

 2 Not decided  

 3 Not decided  

 4 Not decided  

 5 Not decided  

 6 Not decided  

 7 Not decided  

*5 Refer to the following bit-by-bit content for the information index. 

Information index Bit pos Contents Comment 

0 0 Ready Indicates that the axis is ready for movement. 

 1 Not decided  

 2 Not decided  

 3 CAP Indicates that the c-phase signal of the Amp has been caught. 

 4 BreakOn Indicates the magnetic break On/Off status of the axis. 

 5 DBreakOn Indicates the electric break On/Off status of the axis. 

 6 ServoOn Indicates the servo On/Off status of the axis. 

 7 Fault Indicates whether an error of the axis module occurred or not. 

1 0 DesirVel0 Indicates that the Command velocity is zero, stopped state. 

 1 InPosition Indicates the state where the axis has entered within the range in InposRange of the 

parameter. 

 2 InRange Indicates the state where the axis has entered within the ranges of InRangeL and InRange 

of the parameter. 

 3 Not decided  

 4 Not decided  

 5 Not decided  

 6 Not decided  

 7 Not decided  

2 0 FLS(soft) Indicates whether the forward limit sensor set by the software has been detected or not. 

 1 RLS(soft) Indicates whether the reward limit sensor set by the software has been detected or not. 

 2 ORG(soft) Indicates whether the orgin sensor set by the software has been detected or not. 

 3 Not decided  

 4 Not decided  

 5 FLS(hard) Indicates whether the limit sensor in the increase direction of the encoder has been 

detected or not. 

 6 RLS(hard) Indicates whether the limit sensor in the decrease direction of the encoder has been 

detected or not. 

 7 ORG(hard) Indicates whether the origin sensor on the hardware has been detected or not. 

*6 Refer to the following bit-by-bit content for the information index. 

Information index Bit pos Contents Comment 

0 0 FromEMG Indicates the emergency stop input, which is attached to the front panel of the controller. 

 1 TboxEMG Indicates the emergency stop input of the teaching pendant. 

 2 OP EMG Indicates the emergency stop input of the Operating Box. 

 3 Not decided  

 4 Not decided  

 5 Not decided  

 6 UserSeqRun Indicates that the user sequence program is running. 

 7 SysSeqRun Indicate that the system sequence program is running. 

1 0 FrontKeyR Indicates the input of STOP/RST SW, which is attached to the front panel of the controller. 

 1 FrontKeyG Indicates the input of START/ORG SW, which is attached to the front panel of the 

controller. 

 2 FrontKey3 Not decided 

 3 FrontKey4 Not decided 

 4 FrontKey5 Not decided 

 5 FrontKey6 Not decided 

 6 Not decided  

 7 Not decided  

2 0 Not decided  

 1 Not decided  

 2 Not decided  

 3 Not decided  

 4 Not decided  
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 5 Not decided  

 6 Not decided  

 7 Not decided  

*7 For detailed information, refer to the user manual for the device. 

*8 Bit operation takes place in “ON : CW direction and OFF : CCW directions”. (ON operation is not possible when 

inverted/pressed) 

*9 Select a method when the JOG moves. Setup data (word value) has the following meanings. 

Data (word value) Comment 

0 Continuous Jog 

1 Inch Jog 

*10 Select the JOG motion method. Setup data (word value) has the following meanings. 

Data (word value) Comment 

0 XY 

1 Joint 

*11 Jog speed parameter. (Data setup range: 0–3) 

JMOV setting value Comment 

0(Continuous Jog) Refers to the values of JogSpd0 – JogSpd3 

1(Inch Jog) Refer to the values of JogSpd0 – JogSpd3 for speed and the values of JogInch0 – JogInch3 for travel distance. 

*12 JOG speed ratio value (Data setup range: 1 to 100, unit: %) → Refer to JSPD setting value for detailed settings. 

*13 Unit: mm (ARCH OFF when data is “0”) 

*14 “X 0.001” operation is required for data.   *15 Unit: RPM 

*16 Turns ON/OFF the servo. (invert operation not possible) 

*17 [Bit operation: On] Jog CW direction movement (corresponding axis) / [Bit operation: Off] Jog stop (invert operation not 

possible) 

*18 [Bit operation: On] Jog CCW direction movement (corresponding axis) / [Bit operation: Off] Jog stop (invert operation not 

possible) 

 

(2) Program 

Contents Bit Address Word Address Remarks 

Operation file ID ––––– PID1 – PID4 *F1 

Entire run PALL1 – PALL4  *F1 *2 *4 

Line run PLIN1 – PLIN4 ––––– *F1 *2 *4 

Stop PSTOP1 – PSTOP4 ––––– *F1 *2 *4 

Restart PNEW1 – PNEW4 ––––– *F1 *2 *4 

Reset PRES1 – PRES4 ––––– *F1 *2 *4 

[Address format] 

*F1 Channel  

*1 Read only    *2 Write only   *3 32Bit address  

*4 Only Bit operation > ON, Bit operation > OFF is possible. ON function cannot be used when inverted/pressed. 

 

 

(3) Sequence 

Contents Bit Address Word Address Remarks 

Execute system sequence SEQS ––––– *2 *4 

Execute  user sequence SEQU ––––– *2 *4 *5 

 File ID ––––– _SEQU_F  

User sequence file ID ––––– SEQUID *1 

*1 Read only    *2 Write only   *3 32Bit address  

*4 Operate with bit operation “ON: program stop, OFF: program execution”. (ON operation is not possible when 

inverted/pressed.) 

*5 Execute for the file ID set in “_SEQU_F”. 
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(4) Robot movement – 1 

Contents Bit Address Word Address Remarks 

Robot moving speed ––––– RSPD1 – RSPD4 *F1 *4 

Stop robot movement RSTOP1 – RSTOP4 ––––– *F1 *2  

Run robot origin RORG1 – RORG4 ––––– *F1 *2  

[Address format] 

*F1 Channel 

*1 Read only    *2 Write only   *3 32Bit address  

*4 Range (1–100), Unit (%) 

 Refer to the Ref RPM parameter value for the reference speed upon PTP moving (MPTP, MINC). 

 Refer to the Basic Spd parameter value for the reference speed upon interpolation moving (MLIN, MCIR). 

 

 (5) Robot movement – 2 

While the controller operates (origin execution/program execution/movement/JOG), the commands as below are not executed. 

Contents Bit Address Word Address Remarks 

Movement of 

absolute 

position 

Coordinate 

value 

*H1) 

JOINT-PTP AMCA1 – AMCA4 ––––– *F1 *2 *4 

JOINT-LINEAR AMCB1 – AMCB4 ––––– *F1 *2 *4 

JOINT-ARC AMCC1 – AMCC4 ––––– *F1 *2 *4 

JOINT-CIRCLE AMCD1 – AMCD4 ––––– *F1 *2 *4 

XYZ-PTP AMCE1 – AMCE4 ––––– *F1 *2 *4 

XYZ-LINEAR AMCF1 – AMCF4 ––––– *F1 *2 *4 

XYZ-ARC AMCG1 – AMCG4 ––––– *F1 *2 *4 

XYZ-CIRCLE AMCH1 – AMCH4 ––––– *F1 *2 *4 

Reference coordinate value ––––– _AMC1/0 – _AMC2/5 *F1 *3 

Position type 

variable 

*H2) 

PTP AMLA1 – AMLA4 ––––– *F1 *2 *5 

LINEAR AMLB1 – AMLB4 ––––– *F1 *2 *5 

ARC AMLC1 –AMLC4 ––––– *F1 *2 *5 

CIRCLE AMLD1 – AMLD4 ––––– *F1 *2 *5 

Reference position type variable ––––– _AML1 – _AML2 *F2 

Point file 

*H3) 

PTP AMPA1 – AMPA4 ––––– *F1 *2 *5 

LINEAR AMPB1 – AMPB4 ––––– *F1 *2 *5 

ARC AMPC1 – AMPC4 ––––– *F1 *2 *5 

CIRCLE AMPD1 – AMPD4 ––––– *F1 *2 *5 

Reference point file ID ––––– _AMP_F  

Reference point number ––––– _AMP1 – _AMP2 *F2  

Movement of 

relative 

position 

Coordinate 

value 

*H4) 

JOINT-PTP RMCA1 – RMCA4 ––––– *F1 *2 *4 

JOINT-LINEAR RMCB1 – RMCB4 ––––– *F1 *2 *4 

XYZ-PTP RMCE1 – RMCE4 ––––– *F1 *2 *4 

XYZ-LINEAR RMCF1 – RMCF4 ––––– *F1 *2 *4 

Reference coordinate value ––––– _RMC0 – _RMC5 *F3 *3 

Position type 

variable 

*H5) 

PTP RMLA1 – RMLA4 ––––– *F1 *2 *5 

LINEAR RMLB1 – RMLB4 ––––– *F1 *2 *5 

Reference position type variable ––––– _RML *F2 

Point file 

*H6) 

PTP RMPA1 – RMPA4 ––––– *F1 *2 *5 

LINEAR RMPB1 – RMPB4 ––––– *F1 *2 *5 

Reference point file ID ––––– _RMP_F  

Reference point number ––––– _RMP *F2 

[Address format] 

*F1 Group index /data index 

*F2 Group index  

*F3 Data index  

*F4 Channel  

☞ Continued on next page.
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[Help] 

*H1 – Move the robot (axis) from the current position to the specified absolute position. 

– Refer to group 1 (data 0–5) and group 2 (data 0–5) of “_AMC” area. 

*H2 – Refer to the position value of the specified position type variable to move the robot (axis) to the 

absolute position. 

– Refer to group 1 and group 2 of “_AML” area. 

*H3 – Refer to the position value in the point number within the specified point file to move the robot (axis) 

to the absolute position. 

– Refer to groups 1 and 2 of the “_AMP_F” area (file number) and “_AMP” area (point number). 

*H4 – Compensate for the specified relative position (coordinate value) in the current position to move the 

robot (axis). 

– Refer to (data 0–5) of “_RMP” area. 

*H5 Compensate for the position value of the specified position type variable in the current position to move 

the robot (axis). 

– Refer to group 1 of “RML” area. 

*H6 Compensate for the position value in the point number of the specified point file in the current position 

to move the robot (axis). 

– Refers to group 1 of “_RMP_F” area (file number) and “_RMP” area (point number). 

*1 Read only    *2 Write only   *3 32Bit address  

*4 ON (Arm posture: Rignt) / OFF(Arm posture: Left) 

*5 Only Bit operation > ON, Bit operation > OFF is possible. ON/OFF operates in the same way. ON function cannot be used 

when inverted/pressed. 

 

 

☞ Continued on next page.
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(6) Variable 

Contents Bit Address Word Address Remarks 

I/O contact IO0.0 – IO998.7 IO0 – IO998 *F1 *4 

Integer type variable ––––– GINT0 – GINT998 *F1 *3 *4 

Real type variable ––––– GFLT0 – GFLT998 *F1 *3 *4 

Position type variable 

(axis/position) 

––––– POSA0/0 – POSA6/998 *F2 *3 *4 

[Address format] 

*F1 Address 

*F2 Internal variable index / Address 

 0–5: each axis position data, 6: position 

information data 

  

*1 Read only    *2 Write only   *3 32Bit address 

*4 OFFSET function can be used for address. 

 

 

(7) File 

Contents Bit Address Word Address Remarks 

Point file 

(axis/position) 

 ––––– PNTA0/0 – PNTA6/999 *F1 *3 *6 

Channel ––––– _PNTA_CH  

File ID ––––– _PNTA_F  

Delete file ID Run FDLT ––––– *2 *4 

 File ID ––––– _FDLT_F  

Copy file ID Run FCPY ––––– *2 *5 

 Source File ID ––––– _FCPY_SF  

 Destination channel ––––– _FCPY_CH  

 Destination File ID ––––– _FCPY_DF  

[Address format] 

*F1 Internal variable index  / Address 

 0–5: each axis position data, 6: position 

information data 

  

*F2 File ID 

*1 Read only    *2 Write only   *3 32Bit address 

*4 Delete the setting File ID (_FDLT_F). 

*5 Copy the Source File ID (_FCPY_SF) of the point file directory to the Destination channel (_FCPY_CH)/File ID (_FCPY_CF). 

*6 OFFSET function can be used for address. 

 

(8) Parameter 

Contents Bit Address Word Address Remarks 

Parameter ––––– PAR0/0 – PAR99/99 *F1 *3 

Parameter version ––––– PARV *1 *3 

[Address format] 

*F1 Field / Index 

*1 Read only    *2 Write only   *3 32Bit address 

 

 

 


